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Time Slots
Working in the Admin UI



To change the account name, follow these steps in the Admin UI:

1. Navigate to Global Setup /  Business page
2. At the top of the page, select Business Settings /  Business Address / Business

Name.
3. Here, you can edit the account name.

Please note: The name change will not be visible immediately. You must log out completely and
then log back in to see the updated name.

Account
How do I change the name of my account?

https://help.pickatime.com/books/additional-event-features/page/global-setup-business-page
https://help.pickatime.com/books/additional-event-features/page/global-setup-business-page


You can set up any number of users with Administrative access. To do so, you would go to the
Contacts page, select the Add > Admin... button, and then fill in the user information on the
Add New Contact form. For a full-powered administrator in the Admin Level pull-down, select
Administrator. 

Appointment Viewer - allows a contact to view the appointments made. Teachers are
generally assigned only this access. 
Appointment Maker - allows a contact to make appointments in the Admin tool, but not
change any settings on the account. 
Resource Administrator - allows a contact to have administrative access to specific
resources (teachers). This would give the contact the ability to edit the schedule for the
resource. 
Event Administrator - allows a contact to have administrative access to the entire
event. Administrator - allows a contact to have full administrative access to the entire
account. 

This means that the teacher's email address you added already exists with an account in
pickAtime. In the Contacts page, search for the email address by entering it in the email box and
pressing search. You should see that the teacher's email address already has an account in your
Contacts.

Yes, you can add another admin with the access level of Appointment Viewer. To add an
Appointment Viewer do the following:

1. Navigate to Contacts: In the Admin UI, go to the Contacts page.
2. Add New Admin: Select the Add > Admin... button.
3. Enter Details: Fill in the user information on the Add New Contact form.
4. Set Access Level: In the Admin Level pull-down menu, select Appointment Viewer.

Administrators
Can I have multiple administrators on my account? 

What Administrative Access levels are there? 

I'm getting the message "email address already exists, can't
create doubles" when I add a teacher email address. What
does this mean?

We would like to add another person to our account and give
them only report access to a teacher. Is there a way for me to
do this without giving any full Admin access?

https://help.pickatime.com/books/pta-management-guide/page/contacts


5. Save: Click to finish.

Note: If you see a red message stating "Vendor already has a contact with this email," do not
panic. Click the blue Go back button and use the Search tool to find the existing contact by name.

Once the contact is created or located:

Go to the Vendor Access tab.
Locate the specific Event and Teacher this person needs to monitor.
Click the checkbox next to the name to grant report access.

You can provide these steps to the new admin to help them get started:

URL: Go to pickatime.com.
Step 1: In the Login section, enter your email address and press Login.
Step 2: On the following page, you will be prompted to create a unique password for your
account.

Assigning Specific Access

First-Time Login Instructions

https://pickatime.com/


This means that you have appointments that have some sort of problem that needs attention.
When a problem appointment is created, the tab will turn red, and the appointment will be listed in
red. There are several ways problem appointments are created. Please see the Problem
Appointments page. 

Appointments that are in the process of being booked are displayed in orange on the Appointment
List page and cannot be manually deleted or selected for email notification sending. These
appointments will be automatically managed and, if necessary, canceled by the system if the user
has been inactive for a long time and has not completed creating an appointment. Once the parent
completes the appointment booking process and clicks on the Create Appointment button, the
status will disappear.
This will allow admins who are booking appointments for clients in the Admin UI tool to not select
the time slots that are in the booking process.

On the Appointments page, select the Teachers drop-down and then select the Sort Teachers
option. This will sort your teachers by the sort order that is listed on the Global Setup / Business 
page, in the Account Level Display Options / Display Contact Name as section. The options are last
name, first name, or first name last name.

Go to the Events Preview page, select the Events Settings option, change the setting in the 
Propagator Mode section, under Propagate Changes to: from all events of this type to only the
current event. This setting allows you to make changes to one event apply to all your events.

Yes, you can use the Category Sort option to control what is seen and how it is seen on your
account.

Admin UI
Why is the Appointments List red? 

On the Appointments List page, I noticed orange appointments with the
status 'Customer is creating this appointment'. What do we need to fix
these?

How do I sort my teacher roster?

Every time I change the Open scheduler to customers on one of my events,
it changes this on my other events? Why are my events connected?

Is there a way to allow my parents to only see a certain event on our
account?

https://help.pickatime.com/books/additional-event-features/page/appointments-list
https://help.pickatime.com/books/additional-event-features/page/appointments-list
https://help.pickatime.com/books/additional-event-features/page/global-setup-business-page
https://help.pickatime.com/books/additional-event-features/page/global-setup-business-page
https://help.pickatime.com/books/additional-event-features/page/category-options


Yes, you can. Simply create separate time slots for each appointment type:

Use the "Virtual" slot type for the morning or early afternoon hours.
Use the "In-Person" slot type for the evening hours.

There are two options:

Participant: They can go to the My Appointments page, locate the appointment, click
Edit, and change the Appointment Type.
Admin: In the Admin UI:
1. Open the event.
2. Locate the resource and the corresponding time slot.
3. Click on the Appointment, then click Edit Appointment.
4. Change the Appointment Type and save.

In the Admin UI:

1. Open the event.
2. Go to the Event Management page.
3. Click Slots / Update Slots.
4. In the Slot Updater pop-up:

Set the desired time range.
Choose the new appointment type from the Slot Type drop-down.
Click OK.

5. A confirmation message will appear, informing you how many existing appointments will
be updated.

6. Click OK to proceed. All affected appointments will be updated to the new type.

Appointments
I would like to offer Virtual appointments for part of the day (e.g.,
morning/early afternoon) and In-Person appointments for another part of
the day (e.g., evening). Can I set that up?

A participant accidentally booked an In-Person appointment but needs a
Virtual one. How can we change the appointment type?

I want to change all booked appointments from In-Person to Virtual (or vice
versa). How can I do this?



With the PTA (Parent Teacher Appointments) product, parents are limited to one appointment per
student, teacher/class combination. 

The default for each class is one appointment per parent / per teacher. You can change this default
to allow for more than one appointment for a specific class. If you go into the Class Editor and click
on a teacher, you will see their classes listed. On the far right-hand side of each class is a column
labeled PTAN (for Parent Teacher Appointments Number). If you increase this to 2, then any parent
of a student in that class can make 2 appointments with that teacher. If you only have some kids in
the class you want to allow this for, then probably the best way to do this would be to create a new
class and fill this class with your select group of kids. To do this, you would click on the correct
teacher name in the Class Editor roster and then click on the Add Class button. Then you would add
students to this class. For this new class, you could set the PTAN to 2. Then any parent with a
student in this class could book 2 appointments. 

Both these settings place additional limits on appointment bookings.

If you check the box "one appointment per class", then a parent with twins (or siblings) in the same
class (same teacher) can only book one appointment.  

If you check the box "one appointment per teacher, then a parent with a student who has the
teacher for two classes can only book one appointment. For example, if student A has teacher B for
both Math and Science, the parent will only be able to book one appointment with teacher B.

Appointment Limits
How can I limit parents to one appointment per teacher? 

What is PTAN?

Could you clarify the following settings: "one appointment per class" and
"one appointment per teacher"?



This means that you have appointments that have some sort of problem that needs attention.
When a problem appointment is created, the tab will turn red, and the appointment will be listed in
red. There are several ways problem appointments are created. Please see the Problem
Appointments page. 

Could you clarify the following settings: "one appointment per class" and "one appointment per
teacher"? 

Both these settings place additional limits on appointment bookings. If you check the box "one
appointment per class", then a parent with twins (or siblings) in the same class (same teacher) can
only book one appointment. If you check the box "one appointment per teacher, then a parent with
a student who has the teacher for two classes can only book one appointment. For example, if
student A has teacher B for both Math and Science, the parent will only be able to book one
appointment with teacher B.

Appointments List
Why is the Appointments List red? 

Appointment Settings

https://help.pickatime.com/books/pta-management-guide/page/problem-appointments
https://help.pickatime.com/books/pta-management-guide/page/problem-appointments


To view canceled appointments: In the Reporting section, check the Account Reports radio button.
Then select the report labeled Canceled Appointments. Click on the Additional report fields /
Appointment Fields line to add Student and Teacher to the report. Click on the Additional report
fields / Contact's Fields line to add Email to the report. You can sort by the teacher's name to locate
all appointments for a teacher. 

Canceled Appointments
Can I see a list of Canceled Appointments for a teacher? 

https://help.pickatime.com/books/pta-management-guide/page/reports


If there are classes where you do not want parents to book appointments, you have two options:
delete the class or set it to Hidden.

1. Go to the Class Editor page.
2. Select the teacher.
3. From the teacher’s class list, select the class.
4. On the right-hand side, toggle the Type column from Shown to Hidden.

This will prevent the class from appearing in the parent scheduler.

Alternatively, you can delete the class. Just be careful not to remove the wrong one—if that
happens, you’ll need to re-import your data.

In the Admin UI, select the Class Editor tab. Then select the Add Teacher/Team -> Add Teacher tab.
A dialog box called Select Person will pop up. Enter in the Last name, First name, and Email of your
teacher and then press the Add Contact button. Then press the Ok button. You will then see the
new teacher's name listed in your Teacher list in the Class Editor. See also the Modifying Teacher
or Room Data section. 

In the Admin UI, select the Class Editor tab. Select the Teacher from the list on the left. Select the
Class to be moved. Select the Move class button. Select the teacher's name that the class should
be moved to 

In the Admin UI, select the Class Editor tab Click on a teacher, and then click on the Class If your
student has already been added to your account, then type in the student name in the empty box
on the far right-hand side and press enter If your student has not been added to your account,
select the Enroll Student icon () above the roster of students. This will bring up a dialog box
labeled Select Person. Select the Show Full Dialog button. Select the Add Contact button and

Classes
Classes
I’d like to hide some classes on my account so parents can not book those
classes

Class Scheduling Changes 
How do I add a new teacher without importing again? 

How do I move a class from one teacher to another? 

How do I add a new student to a class? 



enter in the student information in the right-hand side where you see the <not entered> fields and
press the Ok button. This will add the student to the class. The student will also be added as a
contact on your account. See also the Modifying Enrollment Data section. We've opened up our
scheduler, but are missing some classes. If you have not made any manual changes to the classes
and enrollment within the Admin UI, you can simply import updated class and enrollment files. A
new import will not replace what was previously imported, but it will add in any new class and
enrollment data. If you have made manual changes in the Admin UI (i.e., changing teachers,
moving kids from one class to another), then you will want to import a class file with ONLY the
missing class(es) and an enrollment file with ONLY the missing enrollment. These options will not
disturb any appointments that have already been made. 

If you have not made any manual changes to the classes and enrollment within the Admin UI, you
can simply import updated class and enrollment files. A new import will not replace what was
previously imported, but it will add in any new class and enrollment data. 

If you have made manual changes in the Admin UI (i.e., changing teachers, moving kids from one
class to another), then you will want to import a class file with ONLY the missing class(es) and an
enrollment file with ONLY the missing enrollment. 

These options will not disturb any appointments that have already been made. 

Yes, you would need to do the following:

1. Make sure the Administrator/Counselor/Teacher is listed in the Contacts section of your account.
If not, then manually add the new contact, making sure there is a TeacherID listed for the contact.

2. Then create a Class File and either import it or manually add the class on the Class Editor page. 

3. Create an enrollment file, listing the studentID for each student in the school and assigned to the
newly created class. 

4. Import your class file (if you have not manually added the class) and import your enrollment file. 

Your parents will see that the administrator and class are available for booking. 

See also here for more related information: Adding a class for counselors.

We've opened up our scheduler, but are missing some classes.

We have a couple of administrators that we would like to show up on each
parent's scheduler for booking. Can we do this? Do we need to create a
class and enroll all the students in that class? 

https://help.pickatime.com/books/additional-event-features/page/adding-counselors-or-other-non-teachers-to-your-event


Blue means that the contact (person) has never logged in and taken ownership of their account.
Black means that the person has logged in. Also, we have contacts that are marked in red. Red
means a problem account - usually indicating that the email address is a duplicate.

Contacts
Why are the contacts different colors? 



When the class file is imported, teacher data is copied onto the resource section in the 
Appointments page, and will not change unless you edit it on the Appointments page. Editing it in
the Contacts section will not update the Appointments page. Make your correction to the room
number on the Appointments page by correcting or entering the room number to the right of the
teacher's name. 

If all teachers have new room numbers, then you can update them via import:
You have to import the Teacher file with the updated Room numbers, then import the Class file,
after this action the room numbers would be updated for all individual teachers you have on the
event. This would not work for the Team of Teachers; you would need to edit the room number for
Teams manually.

Data Edits
I edited the Room Number in the Contacts section, but it does not show up
on the Reports.



If you're using Microsoft Excel:

1. Open the File menu and select the Save as... command.
2. In the Save as type drop-down box, select the Text (tab-delimited) (*.txt) option.
3. Select the Save button. If you see warning messages pop up, select the OK or Yes

button.

If you're using Google Sheets:

1. Open the File menu in the top left corner of the spreadsheet.
2. Hover over the "Download" option in the dropdown menu.
3. Select "Tab-separated values (.tsv, current sheet)" from the side menu. This downloads the
currently selected sheet as a .tsv file.

Correct your student file and import the file again. The system will look for a matching student ID
and then update the security value (birth date) field. 

Correct your student file and import the file again. The system will look for a matching student ID
and then update the First Name and the Last Name field. 

Data Files
How do I create a tab-delimited text file? 

The birth dates for my students were imported incorrectly. 

My teacher (student) names were reversed when I imported them. I had the
Last Name in the First Name column and vice versa. 



The easiest solution is to delete all your classes and then re-import a new file. 

Go into the Class Editor and click on the "show only classes" option on the far right-hand
side. 
Click on your first class, then shift select your last class to highlight all your classes
Select the Delete Selected Classes button.
Import the correct class file

Data Imports
Help! I imported last year's data / the wrong class file



Yes, what you can do is move the slots and appointments. This is done in the Slot Editor. Click on
the original date on the calendar on the left hand side and then click on the Move Slots button.
This will allow you to move the slots and appointments to a new date. You will have the option to
send out an email notifying participants. 

Date
I have a current event set on the site, but the date needs to be changed.  Is
there a way to update the date, but keep the existing appointments?

Note that you will want to correct the date you have listed on the Event Setup page, as this
does not change when you move the slots. 

https://help.pickatime.com/books/pta-setup-guide/page/step-three-create-time-slots


The "Duplicate PTA" option creates a copy of an old event, including the exact same class and
enrollment data. This should only be used if your enrollment data remains unchanged, such as with
full-year classes. Please note that it does not duplicate time slot information. We selectively enable
this feature to prevent it from being used inadvertently.

If you plan to import new data files, you can create a new event using a previous event as a
template. This will copy your previous settings to the new event.

To do this, go to the Events / Preview page and click the Add button. In the Template event drop-
down menu, select your last event and click Add.

​If your new event will contain the exact same enrollment data as the previous one, let us know,
and we will enable the Duplicate PTA option.

Duplicate PTA
I'd like to use the Duplicate PTA option, but it is not enabled. 

https://help.pickatime.com/books/additional-event-features/page/events-preview-page


This can be viewed on the individual contact level. On the Contacts page, you can search for a
contact by name. Then click on the contact and then click on the small Log tab. This will show a log
of appointments booked, canceled, and any emails sent. 

To turn off your reminder emails, go into the Events Management/Settings / Notification

Setup page, and under the Reminder email option, you will see a check box labeled " Send
Reminder Emails". Uncheck this box.

We would recommend that you use the include a table of appointments within the body of the 
reminder emails. If you go into the Settings / Notifications Setup page and select the Reminder
email option, you will see a check box (above the body) labeled " Replace the Email Body with the
Printable Schedule of Appointments". This will take the schedule of appointments (in a table
format) and use this as the body of the reminder email. Any text you add in the Header will show
up above the table of appointments.

The format of the printable schedule is set in the CUI Messages / Print Schedule section. This
table does include the room number. 

On the Settings/UI Setup page under the Customer Reminder Email section, you have checked
the box to require a reminder. You also need to enter the number of hours (prior to each
appointment) for which the reminder will go out. For the Automatic Reminder Email(s), select the
green +  under the Send Reminder Emails and then enter the number of hours prior to the
appointment you would like the email sent (e.g., 24, 48 etc).

Yes, you can change the verbiage and add/remove the times of your Reminder Emails at any time.
These updates will apply to all appointments.

The Macro Field for Class Name is $(CLASS_NAME). If you are using the Printable Schedule option
for the Email Confirmation (recommended), then add a Class Name Column heading on the 
Settings / CUI Messages page under Print schedule / Print schedule headings. Then add in the
macro for Class Name on the Print schedule / Print schedule appointment.

Emails
How can I view any emails that have been sent? 

How do I turn off my E-Mail Reminders?

E-Mail Reminders

Can I change the time/verbiage of my reminder emails?

How do I display the Class name in the Confirmation email to my parents?

https://help.pickatime.com/books/pta-management-guide/page/contacts
https://help.pickatime.com/books/additional-event-features/page/notification-setup-page
https://help.pickatime.com/books/additional-event-features/page/notification-setup-page


I'm testing the confirmation email and I have not yet received it. Does it take a long time?

The confirmation email is sent approximately 20-25 minutes after the parent books their
appointments. We do not send the email immediately, as we wait to make sure the parent has
completed booking all their appointments

If you book and then immediately cancel your appointments, pickAtime will send a cancellation
email, but not the confirmation one. Also, for the PTA product, we wait 20 minutes before sending
out an email; this is to ensure that the parent has finished booking their appointments. 

I booked and canceled some test appointments. Will I receive any emails?



1. Make sure you start with an empty event. On the Events page, click on the " Add " button
to add a new empty event.

2. Remove the stored contacts. Go to the Global Setup /  Contacts page, click on the Show
advanced options... at the top, and you can see the Remove all customers button. Then
select the level to delete for Event Administrators. Parents / Teachers will then log in as a
new contact and create a new password. 

IMPORTANT NOTE: This step should NOT be done after you have imported your data, only
before. 

When you have teachers who are on multiple events, if a parent books an appointment on one
event, the corresponding slot on the other event will be blocked out. This is to prevent the teacher
from being double-booked. If you block out slots on one event, the corresponding slots for the
same teacher on the other event will also be blocked out. 

If you would like to block out a time for one of these teachers on one event, but not on the other
event, then you should delete the time slot rather than use the block feature.

You would create your conference event with the type of PTA as your template. You would then
prepare your data files and import them.

1. Students - take the students' rosters you have and prepare the students' file.
2. Teachers - take counselors' details (First, Last, Email, TeacherID) and prepare a teacher's

file.
3. Classes - you need TeacherID, ClassID and ClassName. ClassID could be a combination of

the counselor's Last Name + class, e.g., 'Smithclass'. Class Name e.g., 'Counselor Smith'.
4. Enrollment - for enrollment, you would need the student's ID value and ClassID value.

If you only have up to 5 counselors can easily add them manually in the pickAtime, and you can
skip the data import of the teacher and class files (steps 2-3 above). 

In the Contacts section, search first for the teacher by name. If you do not locate the teacher, click
on the Add New button and fill in the middle section (where you see <not entered>). Then, in the

Events
I want to start with a new event for the Fall. I'd like all the old data to be
removed.

I have two events, and some of the teachers are the same in both events. 

How could I create the conference event with counselors if I have their
names and IDs, and their students' rosters?

https://help.pickatime.com/books/additional-event-features/page/global-setup-contacts-setup
https://help.pickatime.com/shelves/parent-teacher-conferences-pta
https://help.pickatime.com/books/pta-setup-guide/page/step-two-import-data-files


Class Editor, select the Add Teacher/Team -> Add Teacher option and locate your teacher and
press select. Then select the Add Class option and add a class. ClassID could be a combination of
the counselor's Last Name + class, e.g., 'Smithclass'. Class Name e.g., 'Counselor Smith'.

You can either manually add in students in the Class Editor or import a new enrollment file.

To add students in the Class Editor, click on the counselor's name and then the class. To add the
student to a class, click on the class, and simply type in the student's name in the entry box on the
right-hand side. Be sure to use the format that is selected for your account (either last name, first
name or first name last). When the system finds a match, press Enter. The student will then show
up in the roster of students for the class. Alternatively, you can import an enrollment file for the
class you just added. For the Enrollment file, you would need the student's ID value and ClassID
values.

You will also need to create slots for this teacher by selecting the Create Slots option from the
Slots drop-down on the Appointments page

Is there a way to allow my parents to see a certain event on our account?

Yes, you can use the Category Sort option to control what is seen and how it is seen on your
account.

https://help.pickatime.com/books/additional-event-features/page/category-options


If you only have one open event on your account, you can give your parents the scheduling link for
your account. This URL is located on the Global Setup / Business page under the Account URL.
This link will display any OPEN event on your account to your parents. This means if you have
multiple open events, parents will see a pull-down where they can select an event. 

You can customize the URL by checking the box "custom URL" and entering in what you would like
the XXX part to be in the https://pickatime.com/XXX URL. For example, if you would like your URL
to be https://pickatime.com/myschool you would check the box "set custom URL" and enter in
myschool in the white box. Note that it will take approximately 5-10 minutes for the new URL to be
available. 

IMPORTANT NOTE: The event URL will take the customer directly to the event. However, if you
have any other open events on your account, the event table will be displayed to the parent, and
they will be able to toggle to the other events. You can use the Category Option if you want to
direct a parent to a certain event without an option to toggle to the other opened event on the
account.

Links
Which link should I give to my parents? The scheduling link for the
account or the scheduling link for the selected event?

https://help.pickatime.com/books/additional-event-features/page/global-setup-business-page


Log into your pickAtime account from our home page, the Login section.
Check the radio button for Account Reports.
Select the report labeled Account - Invoices and Payments from the Report pull-down.
You will see a list of your invoices and any payments made. 
Click on an invoice # to see the invoice.

Log into your pickAtime account from our home page, the Login section.
Check the radio button for Account Reports.
Select the report labeled Account - Invoices and Payments from the Report pull-down.
You will see a list of your invoices and any payments made. 
On this report, you have to press on 'click here'. 
You will see the 'Pay by Credit Card' option.

We are unable to take payment over the phone. To pay by credit card, please see the instructions
above.

Invoices
How do I view my invoices?

Can I pay my invoice by credit card?

Can you call me so I can pay your invoice?



In the Admin UI, select the Contacts tab
Search by name for the parent in the Search Control boxes.
When you locate the parent record, click on the record, and you will see the parent's
email displayed in the middle section. 
Click on the Reset PW button.

1. Have the parent log back in and select the Edit Profile option to edit her name on the
account.

2. Go into the Admin UI, locate the parent in the Contacts page, and edit her name.

First, go to the Contacts section of the Admin UI and locate the parent by either first or last name.
From there, you can check to see if the parent booked with one email and logged into pickAtime
with another. You can do this by clicking on the small Log tab and reviewing their activity. Doing
this also tells you if the parent had booked and then canceled and failed to re-book, or if the parent
never booked at all.

For parents who have logged in via mobile phone, select the three-bar menu option at the top of
the page. Then select (under Main Navigation) the green "My Appointments" option to see your
appointments. Next to each appointment is a three-bar menu. Click on it, and you will see up to 4
options to choose from.

Parents will identify their student with two pieces of information. Generally, this is a numeric
StudentID and a SecurityValue (usually the student's birthdate). However, if your parents are
not familiar with a numeric StudentID, it may be preferable to create a StudentID that is a
concatenation of the first and last name (e.g., "BenjaminFranklin"). 

Parents
A parent has forgotten her password

A parent entered her student's name, not her own, when creating an
account

I have a parent who claims that they booked an appointment, but when
they log in, they can't see any appointments

A parent has logged in via mobile phone. How do they locate a list of
booked appointments and manage them?

How do parents identify their student?

My parents do not know their child's StudentID.

https://help.pickatime.com/books/pta-management-guide/page/contacts


You can change the Parent prompt. To prompt your parents for the First Name + Last Name of the
student rather than a numeric security value, go to the Global Setup / Business Setup page of the
Admin UI and check the box in the Miscellaneous section where you see Use First + Last Name as
studentID".  Parents will also need to enter the SecurityValue (if you have imported a birthdate,
then they would enter the birthdate). We do recommend that you go into the Settings / CUI
Messages page and adjust the parent prompt labels. These can be found under Student, and then
they are called StudentID and SecurityValue. Under the StudentID prompt, you can enter
something such as Student First Name + Last Name (e.g., BenjaminFranklin). Under the
SecurityValue prompt, it is helpful to provide a formatting example, such as "Student Birth date
(e.g., 04/12/99)."

You will need to make sure that the parent is entering the same values for the StudentID and the
SecurityValue that you have imported for that student. Search for the student's name in the
Contacts page of the Admin UI. In the right-hand side, you will be able to see the values that are on
the student's account. Make sure that the parent is entering the values exactly as you imported for
the student, or if you have checked the box Use First + Last Name as StudentID on the Global
Setup/Business page, Miscellaneous section, make sure they are entering the student's first name
concatenated with the last name as the studentID.

You can also add the student to the parent account for them. To do this, on the Contacts page,
search on the left-hand side for the parent by name. Select the parent and then select the small
Parents-Students map tab. Under the Student List, you will only see the names of any students
associated with the parent. 
To add a student, click the green "Add" button under the Student List section. The Select Person
dialog box will appear with a list of contacts who have the StudentID value. Select the student and
then click the Add button, and the contact will be added to the student list. 

1. Select the Appointments tab 
2. Select the correct calendar date on the left-hand side 
3. Select the correct teacher name and click on the slot where you would like to schedule the

appointment. 
4. Click on the green plus sign  (). This will bring up the Select Person dialog box. 
5. The student names for the teacher you have selected will be listed on the right-hand side.

Select the student from the list on the right, and press the Ok button. If you need to book
an appointment for a student who is not on the teacher's roster, then uncheck the box
"students of Teacher Name" and search for the student by name. Then select the
student's name and click on the Ok button.  

6. This will bring up the Create appointment dialog box.  
7. If the parent is already associated with the student, the parent's name will display. If this

is the case, select the correct class (if there is more than one class) and press the Ok

When my parent enters in the values for their student, they get an error
message, "failed to find student with the values supplied."

How do I make an appointment for a parent in the Administrative User
Interface?
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 button. 
8. If a parent is not yet associated with the student, click on the green + button. This will

bring up the Select Person dialog box. In the boxes on the upper left-hand side, search for
the parent by name. If you locate the parent, click on the parent's name in the list on the
right and press Ok. Then select the correct class (if there is more than one class) and
press the Ok button. 

9. If you do not locate the parent's name, then on the left-hand side, fill in the parent's First
Name, Last Name, and Email address (if you have it), and then click on the Add Contact
 button. Click on the Ok button. Then select the correct class (if there is more than one
class) and press the Ok button. You should now see the parent name and the student
name displayed in the appointment box. 

You would need to make the appointment for the parent using the Administrative User Interface
(Admin UI). See the Making Parent Appointments section of the site. As the parent is requesting a
longer time slot, you will need to schedule two appointments. The second will be flagged with a red
box, as it is breaking the rules of only one appointment per parent / per teacher. Select the
appointment with the red box and then click on the Confirm Appointment button. This will force the
appointment.

The system will only allow 1 appointment per parent per teacher. For divorced parents, we have a
feature called Clone Student. This will create a second record of the student in the database so that
the second parent can make appointments with all the same teachers as the first parent.

1. In the Contacts page, locate the student. Click on the Clone Student button. You will then
have two records for the student.

2. If the 2nd parent is already attached to the student, you will be asked if you would like to
"clone and separate". Selecting this option will allow you to add the Clone to the 2nd
parent.

3. If the 2nd parent is not already attached to the student, have the second parent log in,
locate the student by entering a studentID followed by an * (ex. 1234*) and birthdate. The
second parent will then be able to schedule another set of appointments. 

Select the Contacts tab, and in the Search control box, enter the parent's or student's first name or
last name and select search. To search for all contacts, simply press Search.

To view the appointments your parent has made, search for the parent's name in the Contacts tab.
When you have the correct parent name and email address listed on the right-hand side, select
the Appointments tab. This will list the appointments that your parents have made. You will have

A parent is requesting a longer appointment than our allowed 15-minute
schedule. How can I accommodate this request?

How do I handle divorced parents who require 2 sets of appointments?

How do I search for a parent or student?

How can I see the appointments my parents have made?



the option to either print or email the schedule to the parent.

On the Reports page, if you click on the Additional report fields link, select Appointment fields, and
check the box next to Created Date, you can add the field to the report. Also, on the Contacts page
of the Admin UI, you can locate the contact and then select the small Log tab. This will show when
the appointment was booked.

Locate and select the parent name in the Contacts section of the Admin UI. This will allow you to
log in as the parent from your administrative account, without needing to know your parent's
account password.  

If you do not know the email address your parent used, you can search for the parent name in
the Contacts section of the Admin UI. In the Contact Info tab, the email address the parent used will
be displayed, and you can copy and paste this to the Login As: box.

If the parent email address is NOT found, you will see a link labeled "Click on the link to add a new
contact". Clicking on this will allow you to enter an email address for your parent and then proceed
to book appointments on the newly created parent record.

If the parent has booked appointments, you will then see a list of the appointments. You will also
have the option of making, changing, or canceling appointments for the parent. The parent will
receive the confirmation/reminder emails, while our system will note in the log section of the
parent's contact account that you booked on their behalf. 

When the parent logs into your scheduling link, she will ONLY be at your link. At the top of the
page, she will see any appointments she has booked at the other school, but if she follows your
link, she will only be at your school and will only be able to book appointments at your school.

Is there a way to see when a conference was scheduled by a parent? Not
the time of the conference, but the time/date it was actually scheduled.

How can I log in as if I were the parent?

A parent has a student at our school and at a neighboring school
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On the login page, the parent can click on the Forgot Password button. A link will be emailed to the
parent with instructions on resetting the password. Alternatively, you can reset the password for
the parent in the Admin UI. Go to the Contacts page, search for the parent. Click on the parent
name and then click on the Reset PW button. 

Log in to your pickAtime account. Click on the menu icon on the upper right-hand side, and then
select the Edit Profile / Change password option

Parents can click on the Forgot Password option, and they will get an email that will allow them to
reset their password. They can also email support@pickatime.com to reset it as well.

Alternatively, in the Admin UI, you can reset the parent password. 

In the Admin UI, select the Contacts tab
Search by name for the parent in the Search Control boxes.
When you locate the parent record, click on the record, and you will see the parent's
email displayed in the middle section. 
Click on the Reset PW button.

Once the teachers have taken ownership of their account and created a password (as they did last
year), the import will not change the password. However, on the Global Setup / Contacts page, if
you click on the Show advanced options..., you would see the Default Password section, where you
would be able to click on the Reset Admin Password button, select this button, and you will have
the option to reset the password by Administrative access level. To reset the password for all your
teachers, select the level to reset in Appointment Viewer.

This message would come up if you import a password for your teachers. For these teachers, let
them know what password you imported. 

Alternatively, you can reset the password for all your teachers. To do so, go to the Global Setup /

Passwords
A parent called and can not remember her password. 

How do I change my password?

A parent is having trouble with her password.

I've imported my teacher file this year with a new password for my
teachers. But it seems that only the password they set last year works?

My teachers are receiving a message to "contact the Administrator" for a
password

http://pickatime.com/
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Contacts Setup page. Click on the "show Advanced options" setting. Then select the Reset Admin
Passwords button to reset all passwords for your teachers. You can also change the default setting
for the password.

On occasion, you may find that you are unable to reset the password for a parent on your account.
If your parent has also logged into another account with pickAtime, such as another school or
organization, you will not be able to reset their password. This is for privacy reasons, as parent
appointments made on other accounts could be confidential. If you receive this error message,
please have the parent contact support@pickatime.com for a new password.

This is a response from Google reCAPTCHA v3. This behavior can happen when a customer has a
bad internet connection.

Refresh the page, and try again.

I'm trying to reset the password for a parent, but I'm getting a message that
says I can not

Sometimes, when my parents try to log in to the site, they are told they are
a bot. Why is that?

http://pickatime.com/


Log in to your pickAtime account and select your event from the Event pull-down. You will see two
empty boxes where you can enter the from date and the to date for your conferences. If your
conference date was in the past, enter in date values for the dates of your conferences.

Yes, in the Admin UI, go to the Global Setup / Business page, Account Level Display Options
 section. Under the Display Contact Name as setting, you could change from first last to last, first.
This will change the sort.

Yes, in the Report Selection section, select the Parents' schedule report from the report pull-down.
On the right-hand side, you will see the option to email each parent an individual report. This will
email each parent their schedule of appointments in a table format. 

Yes, on the Report Selection page, select the report labeled Teachers' Schedule. You will then see a
button labeled Email Report. This will email each teacher their own schedule.

Reports
Our school conferences were last month, but we'd like to view the Reports
from the conference. How do I view conference data in the past?

Is there a way to sort the Student's Schedule report by student's last name
instead of student's first name?

Can I email each parent their schedule? 

Can I email each teacher their schedule?
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When you import a class file, teacher data (including room numbers) is copied to the Appointments
page under Resources. Once copied, this data does not automatically update when changes are
made in the Contacts section.

To correct the room number for a specific teacher, go to the Appointments page and update the
room number directly, to the right of the teacher's name.

If all teachers have new room numbers:

1. Import an updated Teacher file with the correct room numbers.
2. Then import the Class file.

This process will update room numbers for all individual teachers in the event.

Note: This method does not update room numbers for Teams of Teachers — you’ll need to update
those manually on the Appointments page.

Rooms
Why doesn’t the Room Number I updated in Contacts show up in Reports?

Updating Room Numbers for All Teachers



Go to the Events Preview page, select the Events Settings option, change the setting in the
Propagator Mode section, under Propagate Changes to: from all events of this type to only the
current event. This setting allows you to make changes to one event apply to all your events. 

Yes, your event can span multiple days. When you set up your event, click on
the Appointments tab. On the calendar on the left, click on your first date of slots and then select
the Create Slots option from the Slots drop-down menu.  Then select the next date of your event on
the calendar on the left, and continue to create slots on all the days of your event.

Yes, there can be multiple sign-ups for the same time. When you create your slots, you will have
the option of allowing more than one appointment to be made per time slot. When you create the
slots, in the Slot Generator dialogue box, there is an area for the maximum allowed appointments
per slot. This is where you would enter the maximum number of parents who can select the same
time slot. On the scheduling page, once that maximum number has been reached, the slot will not
be displayed as an available time slot.

If you would like to update this number after you have already created your slots, you would do
this in the Appointments page by selecting the Update Slots option from the Slots drop-down
menu. The dialogue box will allow you to update the Maximum allowed appointments per slot for a
specific time period or for all time slots.

To add a logo to your scheduler, go to the Global Setup / Business page. Under the Account Level
Settings / Account Logo, click on the Upload icon to upload your logo.

You can use your browser to translate your page. Review our instructions on how to do this.

The link for your parents is the link for your account. This URL is located on the Global Setup /
Business page on the bottom left hand side. This link will display any OPEN event on your account

Scheduler
Every time I change the Open scheduler to customers on one of my events,
it changes this on my other events. Why are my events connected? 

Can my event span multiple days

Can there be multiple sign-ups for the same slot?

How do I add a logo to my scheduling site? 

Do you have a Spanish/French version of the scheduling page?

What is the link for my parents? Can I customise the link?
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to your parents. This means if you have multiple open events, parents will see a pull-down where
they can select an event. 

You can customise the URL by checking the box "custom URL" and entering in what you would like
the XXX part to be in the https://pickatime.com/XXX URL. For example, if you would like your URL
to be https://pickatime.com/myschool, you would check the box "set custom URL" and enter in
myschool in the white box. Note that it will take approximately 5-10 minutes for the new URL to be
available.

Go to the Online Scheduling link. This will take you into the Online Scheduler. You can add any
student to your account and then view the schedule for the students' teachers.

This means that you have not made the site available for appointment taking. In the Settings /
UI Setup page, check the start date and end date of Scheduler Availability. In order to view the
scheduler, the site must be open for appointment taking.

This could mean a couple of different things. This may mean that you have not created any slots
for your teachers. It could also mean that your slots have all been filled.

Make sure you have set the Open scheduler to customers on and the Close scheduler to
customers on correctly. This is on the Settings / UI Setup page under the Scheduler
Availability section.
If your parents are seeing a message ‘there are no available times’, check to make sure
you have created slots for your teachers.
Make sure you are not within the closed booking window, by checking the setting
‘Customer cannot book their appointment closer than xx hours/days’. If the appointment
date and time are within this window (for example,  if the appointment slot is tomorrow
and you have this set to 1 day), then the parent will not be able to book an appointment.

If you have not made any manual changes to the classes and enrollment within the Admin UI, you
can simply import updated class and enrollment files. A new import will not replace what was
previously imported, but it will add in any new class and enrollment data. 

If you have made manual changes in the Admin UI (i.e. changing teachers, moving kids from one
class to another), then you will want to import a class file with ONLY the missing class(es) and an

How do I test out the scheduler?

When I try to test out the site, I see a message that says "there are no
events available" or "the online scheduler is closed"

When I try to test out the site, I see a message that says "no slots
available?"

Help! My scheduler is not open

We've opened up our scheduler, but are missing some classes.

https://help.pickatime.com/books/pta-setup-guide/page/step-four-adjust-settings


enrollment file with ONLY the missing enrollment. 

These options will not disturb any appointments that have already been made

From the Class Editor page, you can delete classes. Note that this will not delete any appointments
that have been booked for teachers of these classes.

In the Admin UI, on the Appointments page for your event. Select the date of conferences from the
calendar on the left-hand side. Click on the Slots / Move Slots option. Here you will be able to move
all slots and appointments to a new date in the future. You will be prompted to select a destination
date. You will have the option to send an email to all parents with appointments.

In the Admin UI, on the Appointments page for your event, you can delete all slots and
appointments. Select the date of the conferences from the calendar on the left-hand side. Click on
the Slots / Delete Time Slots option. In the dialogue box that comes up you will be able to specify
times and dates for the slots you would like to delete. The system will also let you know how many
appointments exist on your soon-to-be-deleted slots. You will have the option to cancel all these
appointments, and you can choose to send a cancellation email or not. 

On the Appointments page, select the Teachers drop-down and then select the Sort Teachers
option. This will sort your teachers by the sort order that is listed on the Global Setup / Business
 page, , Account Level Display Options section. Under the Display Contact Name as setting, you
could change from first last to last, first. 

When the scheduler closes, if the link is still available (either on your website or bookmarked by the
parent), parents can still log in and view their schedule. They are not able to book any
appointments. 

Depending on your cancellation settings, they can still cancel an appointment. This is determined
by the setting customer cannot cancel their appointment closer than xx hours/days. This setting is
on the Settings / UI Setup page, Appointment Cancellations section. If parents are not able to
cancel, then a message displays that they should call the school to cancel. 

We've opened up our scheduler and need to remove some classes.

Our conferences have been snowed out, we'd like to move all the slots and
appointments to a new date

We have conferences on two days, and we only need to cancel one day of
the conferences. We'd like to let parents continue to book on the day that
is not cancelled.

How can I sort my teachers alphabetically on the Scheduler?

Our scheduler is closed, but our parents could still cancel.

How can I add the Class Name to the scheduler and to the parent email?



On the Settings / UI Setup page, Scheduler Settings section, check the box separate legend for
each child and display class names. This will add the class name to the scheduler. To include the
class name on the Printable Schedule for your parents, add the class name to the CUI Messages /
Print Schedule -> Print Schedule Headings and Print Schedule Footer. The macro for class name is
$(CLASS_NAME).



In the Admin UI, go to the Contacts page and search for the student. Then click on the small
 Appointments tab and you will see the classes the student is enrolled in. Make sure that you see
all the classes that you should for the student. To add a student to a class, go into the Class Editor
page, click on a teacher and then a class, and then click the Enroll Student icon ().

Go into the Contacts section and search for the student by name. Correct
the securityvalue (birthdate) field.

In the Class Editor page, you can add a student to the class. Click on a teacher name, and then the
class name. Select the Enroll Student icon () on the far right hand side above the roster of students.
This will bring up the Select Person dialog box. Click on the Show Full Dialog button. Then click on
the Add Contact button and fill in the correct information for the student in the middle section
where you see <not entered> (first name, last name, securityvalue, and studentID). Then press Ok
. You should see the student added to the roster.

After the student has been added to your account, to add the student to a class, you would simply
type in the student's name in the entry box for the class. Be sure to use the format that is selected
for your account (either last name, first name, or first name last). When the system finds a match,
press Enter. The student will then show up in the roster of students for the class.

In the Class Editor page, students can be moved out of classes and added to other classes. To
remove a student, you would click on the teacher's name and then the class. Locate the student
and select the red x to the left of their name. This will remove the student from the class. To add
the student to a class, click on the class, and simply type in the student's name in the entry box for
the class. Be sure to use the format that is selected for your account (either last name, first name,
or first name last). When the system finds a match, press Enter. The student will then show up in
the roster of students for the class.

To remove older students or the duplicate version of the student, go to Event Management/ Class
Editor, check the box  'show only classes' on the right-hand side, then select all classes via the Shift
key and click the 'Delete selected classes' button. You would then go to Global Setup/ Contacts and
then under the Advanced options, click "remove Students not enrolled in a class". Parents will then
have to attach the new version of the student to their account. 

Students
How do I see the classes for my students?

I need to correct the birthdate for a student

I need to add a new student

My student's schedule has changed

How do I remove duplicate students?





In the Admin UI, go to the Appointments page for your event. Select the date of conferences from
the calendar on the left hand side. Click on the Slots / Move Slots option. Here you will be able to
move all slots and appointments to a new date in the future. You will be prompted to select a
destination date. You will have the option to send an email to all parents with appointments.

In the Admin UI, on the Appointments page for your event, you can delete all slots and
appointments. Select the date of conferences from the calendar on the left hand side. Click on the 
Slots / Delete Time Slots option. In the dialog box that comes up you will be able to specify times
and dates for the slots you would like to delete. The system will also let you know how many
appointments exist on your soon to be deleted slots. You will have the option to cancel all these
appointments, and you can choose to send a cancellation email or not. 

Important Note: In order to let your parents who had an appointment on your first day of
conferences to book on your second day of conferences you will either need to 1) delete all
appointments on the first day of conferences or 2) change the Open scheduler to customers on
 (Settings / UI Setup page) to be a date AFTER your first day of conferences. If you do not do one of
these options, any parent who booked on Day 1 will not be able to book on Day 2. Changing the 
Open scheduler to customers on "resets" our one appointment per student per teacher/class
combination. 

Snow Day
We have conferences that we need to cancel on account of a snow day. We
would like to move all conferences to a new day.

We have conferences on two days, and we only need to cancel one day of
conferences. We'd like to let parents continue to book on the day that is
not cancelled.



On the Appointments page, select the Teachers drop-down and then select the Sort Teachers
option. This will sort your teachers by the sort order that is listed on the Global Setup / Business
page, in the Account Level Display Options /  Display Contact Name section. The options are last
name, first name, or first name last name. 

This means that the teacher's email address you added already exists with an account in
pickAtime. In the Contacts page, search for the email address by entering it in the email box and
pressing search. You should see that the teacher's email address already has an account in your
Contacts. 

The goal is to have her listed twice in the Slot Editor so you can create 30-minute slots for one
listing of her name and 15-minute slots for the second listing of her name. To do this, you will need
the teacher to be listed twice in the Class Editor. 

1. Go to the Class Editor page.
2. Click on the Add teacher button. This will bring up a Select Person dialog box. Locate the

teacher's name, click on the name, and then press select. 
3. You will now see her name listed two times in the Class Editor. 
4. Click on the second listing of the teacher's name. Click on her Kindergarten class and click

on the Move Class button. Then click on the first listing of the teacher's name. This will
move the Kindergarten class to your first teacher listing. 

5. To edit the teacher name (so you can easily identify which class you are creating slots for
in the Slot Editor), click on the listing and edit the name. For example, if your teacher's
name was Sue Smith, you could modify the first listing of her name to Sue Smith -
Kindergarten and the second one to Sue Smith - First Grade. 

6. Go to the Slot Editor page.
7. You will see two references to the teacher listed, and you can create slots of different

durations for each. Since both listings are assigned to the same contact person, the
system will ensure that this teacher does not get double-booked. When a slot is booked
for one listing, the corresponding slot on the second listing will be made unavailable. 

Teachers
How do I sort my teacher roster? 

I'm getting the message "email address already exists, can't create
duplicates" when I add a teacher's email address. What does this mean? 

I have a teacher who needs 15-minute time slots for her First Grade class
and 30-minute time slots for her Kindergarten class. She is only showing
up one time in the Class Editor and the Slot Editor, so how can I set up
different slot durations for her? 
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Probably the easiest way is to go to the Appointments List page. Search for all appointments on
your event. Then sort by parent Last Name (click on the column heading to sort) and then by
Resource (teacher). If you locate your teacher, you will see any parent appointments. You can click
on an appointment and then select the Delete / Delete selected button. 

Go to the Appointments page. To the right of the teacher's name, you can edit the room number. 

Teachers that you import on your teacher file should show up in the Contacts section of the Admin
UI. They show up in the Appointments page (and Class Editor page) AFTER a class has been
imported for them.

Go to the Appointments page. Select your first 3rd-grade teacher from your roster on the right-
hand side, then hold down the Ctrl key and select the other 3rd-grade teachers. When you have
selected this entire group, select the Create Slots option from the Slots drop-down. You will then be
prompted to enter the from and start time of the conferences as well as the duration of the
appointments. Create your slots with a duration of 15.

Using the ctrl key option, repeat this process to collect your 4-5th grade teachers. Then select the
Create Slots option from the Slots drop-down, and in the Slot Generator dialog box, enter an
appointment duration of 20 minutes for this group of teachers.

The goal is to have her listed twice in the Appointments page so you can create 30-minute slots for
one listing of her name and 15 minute slots for the second listing of her name. To do this, you will
need the teacher to be listed two times in the Class Editor.

1. Go to the Class Editor page.
2. Click on the Add Teacher/Team -> Add Teacher button. This will bring up a Select Person

dialog box. Locate the teacher's name, click on the name, and then press select.
3. You will now see her name listed two times in the Class Editor
4. Click on the second listing of the teacher's name. Click on her Kindergarten class and click

on the Move Class button. Then click on the first listing of the teacher's name. This will

A teacher will no longer be available for conferences. How do I cancel all
her appointments? 

I need to edit the Room Number for a teacher

I imported teachers, but I don't see my teachers listed in the roster on the
Appointments page.

My 3rd-grade teachers require 15-minute slots, and my 4-5 grade teachers
require 20-minute slots? How can I do this?

I have a teacher who needs 15-minute time slots for her First Grade class
and 30-minute time slots for her Kindergarten class. She is only showing
up one time in the Class Editor, so how can I set up different slot durations
for her?
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move the Kindergarten class to your first teacher listing.
5. To edit the teacher's name (so you can easily identify which class you are creating slots

for in the Appointments page), click on the listing and edit the name. For example, if your
teacher's name was Sue Smith, you could modify the first listing of her name to Sue Smith
- Kindergarten and the second one to Sue Smith - First Grade.

6. Go to the Appointments page.
7. You will see two references to the teacher listed, and you can create slots of different

durations for each. Since both listings are assigned to the same contact person, the
system will ensure that this teacher does not get double booked. When a slot is booked
for one listing, the corresponding slot on the second listing will be made unavailable. 

To add students in the Class Editor, click on the teacher's name, then the class. To add the student
to a class, click on the class, and simply type in the student's name in the entry box on the right-
hand side. Be sure to use the format that is selected for your account (either last name, first name,
or first name last name). When the system finds a match, press Enter. The student will then show
up in the roster of students for the class. Alternatively, you can import an enrollment file for the
class you just added. count (either last name). You will also need to create slots for this teacher by
selecting the Create Slots option from the Slots drop-down on the Appointments page. 

To turn off the email message that your teacher received, go to the Settings / Notification page,
Resource Email Notification section, and uncheck the box “For resources assigned to a contact,
send appointment notification via email” - this sends an appointment notification email any time a
parent books or cancels an appointment. 

When you see a message like this, it means that either there is a different teacher contact
attached to the resource or there are multiple teachers attached to the same resource. The system
doesn’t allow for double booking and therefore blocks out the time slots. To correct this, go to the
Class Editor and click on the teacher resource that is experiencing this issue and then click on the
“Assign Contact / Team” menu and select “Assign Contact.” From within the dialog box, you will
see the current teacher contact that is attached to the resource. Click on the name of the correct
teacher and then click Ok and the boxes will go back to normal. 

This means that the teacher has either an appointment booked in their role as a parent, or they are
part of a team and they are booked in their role as a team member. 

I’ve already opened my scheduler. Can I add a new teacher? 

My teachers are receiving email notifications every time an appointment is
booked. How do I turn this off? 

I have some time slots that are grey with the message “An appointment
has been booked with ‘teacher name’ at this time

I’m seeing the message “teacher not available” in the Admin UI.

Can I email my teachers their schedule?



Yes, on the Report Selection page, select the report labeled Teachers’ Schedule. You will then see a
button labeled Email Report. This will email each teacher their own schedule. 

Yes, blocking slots in one event will block out the corresponding time slots on the second event for
any teacher sharing the same contact record (matching email address) across events. 

Deleting slots for a teacher in one event will NOT delete slots for a teacher in another event. If you
have a teacher who is not available at the High School during some times, but is available at the
Middle School, you will need to delete the slots on the High School event. 

You can either import a password into the teacher file or let your teachers create their own when
they first log in. If you did not import a password for your teachers, the first time a teacher logs in,
he/she will be prompted to create a password for their account.

In the Admin UI, select the Contacts tab. In the Search control boxes, enter the teacher's first name
or last name and select search.  Click on the teacher name listed in the left hand side. Click on the 
Reset PW button. This will reset the password to the default password of 123456. You can change
this default password by selecting the Global Setup / Contacts page. If you click on the Show
advanced options..., you would see the Default Password section, here you would be able to
change the default password that is used when you select the Reset PW button.

In the Admin UI, go to the Global Setup / Contacts page. If you click on the Show advanced
options..., you would see the Default Password section, here you can find the Reset Admin
Passwords button. Select this button and you will have the option to reset the password at the
administrative access level. To reset the password for all your teachers, select the level to reset of
Appointment Viewer.

This is most likely the case when your teacher is a parent at another school. In this case, the email
address is associated with 2 different accounts, and can not be reset by either one of the two
accounts. The teacher can select the Forgot Password button and have a new password emailed to
him/her, or he/she can email pickatime support (support@pickatime.com) and request that the
password be reset.

Some of my teachers are at two different events, both the High School
event and the Middle School event. I blocked out slots on the High School
event when they wouldn't be available, but this also blocked out their times
on the Middle School event as well. 

How do I set my teachers' passwords?

How do I reset a password for a teacher?

How do I reset the passwords for all my teachers?

The Reset PW button is not available when I select a teacher.

One of my teachers can not view her schedule. How do I fix this?

http://pickatime.com/


There are a couple of things to check for a teacher. 

In the Contacts section of the Admin UI, locate the teacher contact record.
1) make sure she is using the email address listed in the contacts.
2) make sure the Admin Level pull-down is set to Appointment Viewer.
3) make sure the box next to her name in the Resource Access section is checked.

In the Reporting section, if you select the Account Reports option, there is a report labeled List of
Teachers. You can quickly scan this to see the access levels for your teachers.

When teachers are imported, they are automatically set up with Appointment Viewer access, and
with the box checked by their name in the Resource Access section. This allows them to view their
own schedule in the Reporting section.

If you added a teacher in manually, then you would need to set both the Admin Level to 
Appointment Viewer and check the box by their name in the Resource Access section.  

Teachers can view their schedule by logging into the site as well. From your school's account URL,
your teachers should enter their email address and password in the Login section.  Each teacher
will only have access to his/her own schedule. Click here (Directions for Teachers) for a printable
template of instructions for your teachers.

To block out a time for a teacher, you can either:

Delete the time slots using the Delete Time Slots option in the Slots drop-down on the 
Appointments page, or make the slots unavailable with the Update Time Slots option from the Slots
 drop-down on the Appointments page. If you select the Update Slots option, a dialog box will come
up where you can enter in the times to make unavailable, and then select "make unavailable" from
the drop-down option.

Go into the Admin UI.
Then select the Appointments page. Click on the teacher's name and then select Assign
Contact from the Teachers drop-down menu.
The Select Person dialog box will come up with the teacher contact record. Correct the
spelling and then press select in the dialog box.

This will update the teacher's name.

How do my teachers view who has signed up? How do my teachers log in?

How do I block out time for a teacher?

How do I correct the spelling of a teacher's name?

One of my teachers has gone on leave and will be replaced by a long-term
substitute teacher. How can I let parents see the new teacher's name? 



If a teacher is being replaced with a different person, such that all the classes taught by the former
will now be taught by the new teacher, you can reassign the teacher by going again to the Class
Editor tab. 

Select the teacher that you want to replace and select Assign Contact/Team, Assign
Contact. A dialog will pop up that is very similar to the contacts tab.
Search for and select the new teacher, then click "select.



A team can be simply a label for a teacher, such as "Team Blackhawks," or a team can be a
combination of individual teachers. In the pickAtime system, when you create a team of more than
one teacher, we concatenate the teacher names so the team might look something like "Andrea
Smith; Barbara Zook." 

When a team is created by combining teachers, the system ensures that the teacher can not be
double booked. For example, if you have team "Andrea Smith; Barbara Zook" and team "Andrea
Smith; Bob Jones", when a time slot is booked with team "Andrea Smith; Barbara Zook" the system
automatically blocks out the corresponding slot for "Andrea Smith; Bob Jones." 

Another example could be where you have individual teachers and teams. If you have a teacher
"Andrea Smith", teacher "Barbara Zook, and team "Andrea Smith; Barbara Zook", when a time slot
is booked with teacher "Andrea Smith" the corresponding time slot with team "Andrea Smith;
Barbara Zook" is blocked out. Note, however, that the time slot for "Barbara Zook" would not be
blocked out as she is still available. 

You can assign two teachers to one class, and then create slots for this team of teachers. These
teachers can then also have slots for their classes where they teach individually. The system will
ensure that they are not double booked. The teacher is then able to view their schedule as a co-
teacher and as an individual teacher. 

To do this, you can either import on the class file, the name of this class in the classID column, and
the two teacher ID's in the teacher column, with the teacherID's separated by a semi-colon.

Or you can combine your teachers into a team after you have imported your data. To do so, you
would do the following: 

1. Go into the Class Editor
2. Select Add Teacher/Team -> Add Team
3. In the Select Person dialog box that displays, search and click on the first teacher you

would like on your team, then click on the 'Add to Team' button on the Select Person pop-
up window in the top left corner. Then search and click on the 2nd teacher you would like
in the team, then click on the 'Add to Team' button. 

4. Once you have your team selected, all team members would be listed in the top-left
corner of the Select Person pop-up window - press the Ok button. 

You would then want to create a class for that team or move a class from an individual teacher to
the team.

Teams
How do teams work?

Our school has a class that is team-taught. Can I create a team?



In the Class Editor:

1. Select the Add Teacher/Team -> Add Team option
2. In the Select Person dialog box that displays, search and click on the first teacher you

would like on your team, then click on the 'Add to Team' button in the top left corner.
Then search and click on the 2nd teacher you would like on the team, then click on the
'Add to Team' button.

3. Once you have your team created, all team members would be listed in the top-left corner
of the Select Person pop-up window, then press the Ok button.

4. You will then see both teachers' names listed in the Class Editor, separated by a semi-
colon (e.g., Teacher A; Teacher B)

To add classes to the team:

1. Click on Teacher A, click on Teacher A’s class, and click on Move Class. Then click on your
team of Teacher A; Teacher B. This will move Teacher A’s class to the combined teacher.
Repeat for Teacher B

2. Click on the individual teacher (Teacher A) and select the Remove Teacher button. Repeat
for Teacher B

 On the Appointments page:

1. Click on this new combined teacher (Teacher A; Teacher B). Click on the Create Slots
 option on the Slots drop-down and create slots for this teacher

2. Optionally add in a room number

I've already imported my data. I have two teachers and their classes
imported, and I want to combine them into a team.



On the Appointments page, select the Slots drop-down and then select the Move Slots option. This
will allow you to move all slots (and any appointments) to a new date. You will have the option to
send an email to any appointment that is being moved.  

If your break will not have the same duration as your slots or is not a multiple of your slots (e.g.,
you have slots of 20 minutes, and you want a 30-minute break), you will need to create your slots
in sections. First, create the slots BEFORE your break time, and then create your slots AFTER your
break time. 

Grey time slots indicate that the teacher is booked elsewhere and is not available at that time.
Either the teacher is having meetings as part of a team, or the teacher has booked her own
appointments in her role as a parent. If you click on a grey time slot, a message will display telling
you where the teacher is booked.

PickAtime automatically displays older Time slots in yellow to indicate that the scheduled time has
already passed. These slots will not appear to your participants. Check the date of the slots, and
either delete them or move them to the correct date. Slots on the correct date will be blue and will
allow you to book and block.

Time slots can not be changed from one duration to another. If you need a different duration than
what you originally created, you will need to delete your time slots with the incorrect duration and
create new time slots with the correct duration. 

Time slots can not be changed from one duration to another. If you need a different duration than
what you originally created, you will need to delete your time slots with the incorrect duration and
create new time slots with the correct duration. When you delete the time slots, the system will ask
you what you want to do with the appointments. You can cancel them and send an email to each
customer requesting that they reschedule their appointment. Or you can put the appointment “on
hold” and then cancel and manually re book each appointment. 

Time Slots
I created slots on the wrong date? 

My slots are 20 minutes in duration, but I want a 30-minute break in the
middle.

Why are some of my time slots grey? 

Why are some of my time slots yellow?

I created time slots with the wrong duration. 

I created time slots with the wrong duration, but my customers have
already booked appointments. 



After selecting the Delete Time Slots option, you will see a new dialog box telling you the number
of appointments on your soon to be deleted slots. 

The default option is set to move the appointments to a holding area on the Appointments List
page. If you choose this option, you will have a list of the appointments that you need to either
cancel or reschedule. 



Put your cursor on the line indicating the time on the left-hand column. You can then stretch or
shrink the size of the boxes. Alternatively, you can go to the Settings / Vendor View Setup page and
adjust the Time Slot Display Scale. 

Working in the Admin UI
Help! The time slot boxes in the Admin UI are really small. How can I adjust
this? 


